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1.0 Introduction
OnTrak Truck Scale Data Management is a powerful scale data management program. The software tracks customer account 
information, haulers, trucks, products, discounts and inventory. It allows quick and easy report generation, performs weigh in/out, 
stored tare and keyed tare transactions. It also offers a web kiosk for drivers who use wireless devices such as smart phones and 
tablets. 
OnTrak can connect with most Rice Lake indicators and supports both Windows® and serial printers. OnTrak software can be 
downloaded from the Rice Lake website. 

Manuals are available from Rice Lake Weighing Systems at www.ricelake.com/manuals
Warranty information is available at www.ricelake.com/warranties

OnTrak uses a simple approach for processing transactions. Features include:
• Weigh ticket processing
• Hauler and product information
• Report generation by criteria selection
• Customer-specific, product-specific and job specific rates and surcharges
• Inventory management based on shipping and receiving transactions
• Scale interface
• Interface to serial and Windows printers

System Requirements
• Windows® 10 or newer
• 1.5+ GHz processor
• 8+ GB of RAM
• 10+ GB hard drive space

https://www.ricelake.com/manuals
http://www.ricelake.com/warranties
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1.1 Installation
1. Download the OnTrak Truck Scale Data Management program and extract the zip file.
2. Open the OnTrak program folder and launch the OnTrak.Installer.exe file. The Open File - Security Warning popup 

displays.

Figure 1-1. Security Warning

3. Select .
4. Read the Rice Lake Weighing Systems License Agreement. Check the box below the agreement if the terms are 

acceptable.

Figure 1-2. Rice Lake Weighing Systems’ License Agreement

https://www.ricelake.com
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5. Press , then  to install the program in the desired location.
6. Press . Display returns to setup Rice Lake Weighing Systems License Agreement.
7. Press . If not already installed on the PC, Microsoft SQL Server installs. A Database Installer displays.

8. Press . Confirm the SQL Server Name.
9. Select the appropriate radio buttons for the Remote SQL Server Security and Action areas of the display.

• To authenticate the SQL server, select the SQL authentication radio button and enter a user name and password. 
This is only required if connecting to a remote SQL server. For assistance, contact the IT department.

• If creating a new database and sample data is desired, check the box under it. 
• If using an existing database, select it from a drop-down menu. OnTrak’s default database is RLWS_OnTrak®.

10. Press . Installation Complete popup displays.

  IMPORTANT: If there were errors during installation, contact Rice Lake Weighing Systems support. 

Figure 1-3. Database Installer

11. Press . OnTrak is successfully installed. 
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1.1.1 License
OnTrak initially installs in demo mode and a machine ID number is displayed. Record this number, it must be provided when 
contacting Rice Lake Weighing Systems to unlock the program. Once unlocked all of its features will be available.

1. Call Rice Lake Weighing Systems’ sales or tech support at 1-800-472-6703 to purchase the full version of OnTrak 
Truck Scale Data Management. 

2. Provide them with the sales order number and machine ID number. Then a license file will be provided. 
3. Place this file in the installation directory, typically C:\Program Files\Rice Lake Weighing Systems\OnTrak unless a 

different location was specified during installation. 
4. Reopen the OnTrak program. Once the license file is in the correct location the full version of OnTrak will be unlocked. 

IMPORTANT: The license file is specific to the PC it is installed on. Each PC required to run the program must have its own 
separate purchased license file.

Figure 1-4. Machine ID

https://www.ricelake.com
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2.0 Starting OnTrak
OnTrak can be launched from the following location: Start » Programs » Rice Lake Weighing Systems » OnTrak Truck Scale 
Data Management.

2.1 Operating Modes
OnTrak has two modes of operation. The available functions differ depending on the mode that is logged in to. 

2.1.1 Administrator Mode
Administrator mode allows full control of OnTrak. Many of the features described in this manual may require being in 
administrator mode. Log on using the User Name and Password below, both are case sensitive:

User name – Administrator
Password – password

Figure 2-1.  Default Administrator Login.

2.2 User Mode
If logged in as a user, there is only access to make weighments and add transient trucks. The OnTrak database cannot be 
modified nor view reports. See Section 3.5 on page 23.
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2.3 The OnTrak Screen

Figure 2-2. OnTrak Truck Scale Data Management Main Screen.

2.4 Menus
File Menu Function

Login Prompts to enter a user name and password to log into OnTrak Truck Scale Data Management.
Logout Logs the user out of OnTrak Truck Scale Data Management.
Exit Closes the program.

View Menu Function
Users Opens Users dialog box; users can be added, deleted and modified
Customers Opens Customer Report dialog box; add, delete, modify and search customers; run a report to be viewed and printed
Vendor Opens Vendors dialog bLox; add, delete, modify and search vendors; run a report to be viewed and printed
Products Opens Select Product dialog box; add, delete, modify and search products; run a report to be viewed and printed
Haulers Opens Haulers dialog box; add, delete, modify and search haulers; a report can be viewed and printed
Trucks Opens Trucks dialog box; add, delete, modify and search trucks; a report can be viewed and printed
Jobs Opens Select Job dialog box, add, delete, modify and search jobs; a report can be viewed and printed
Discounts Opens Discounts dialog box, add, delete, modify and search discounts; a report can be viewed and printed
Reports » Customer Access Customer Report dialog box; criteria can be entered and reports can be viewed/saved/printed
Reports » Hauler Access Hauler Report dialog box; criteria can be entered and a reports can be viewed/saved/printed.
Reports » Product Access Product Report dialog box; criteria can be entered and a reports can be viewed/saved/printed.
Reports » Truck Access Truck Report dialog box; criteria can be entered and a reports can be viewed/saved/printed.
Reports » Job Access Job Report dialog box; criteria can be entered and a reports can be viewed/saved/printed.
Reports » Discounts Access Discount Schedule Report dialog box, where criteria can be entered and a reports can be viewed/saved/printed.
Reports » Shipping 
Transactions

Access Transaction Report dialog box, where criteria can be entered and a reports can be viewed/saved/printed.
See Section 7.2 on page 44

Reports » Receiving 
Transactions

Access Transaction Report dialog box; criteria can be entered and a reports can be viewed/saved/printed
See Section 7.2 on page 44

Table 2-1.  Menus and Functions

Select Shipping or Receiving 
Transaction Mode

Truck, Job, Customer and 
Product Selections

Menu bar

Tool bar
Weigh button performs 
weigh-ins and weigh-outs

Virtual Indicator

Trucks that have been weighed in (but not weighed out) appear in 
this section. Select one and click the Weigh button to weigh out.

Red light means load is stable

https://www.ricelake.com
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Reports  » Shipping Usage 
Reports » By Product... Access Usage By Product (Shipping) report; displays quantity of selected product shipped during time frame selected

Reports  » Shipping Usage 
Reports » By Customer...

Accesses the Usage By Customer (Shipping) report, displays quantity of loads/total/units of product a selected customer 
has been shipped in time frame selected

Reports  » Shipping Usage 
Reports » By Truck...

Accesses the Usage By Truck (Shipping) report, displays quantity of loads/total/units of product a selected truck has used 
in time frame selected

Reports  » Shipping Usage 
Reports » By Hauler...

Accesses the Usage By Hauler (Shipping) report, displays quantity of loads/total/units of product a selected hauler has 
used in time frame selected

Reports  » Shipping Usage 
Reports » By Job/Customer...

Accesses the Usage By Job/Customer (Shipping) report, displays quantity of products, loads and total units used by job 
and customer.

Reports  » Shipping Usage 
Reports » By Job/Vendor...

Accesses the Usage By Job/Vendor (Shipping) report, displays quantity of products, loads, and total units used by job and 
vendor.

Reports  » Receiving Usage 
Reports » By Product...

Accesses the Usage By Product (Receiving) report, displays quantity of a selected product received during time frame 
selected.

Reports  » Receiving Usage 
Reports » By Customer...

Accesses the Usage By Customer (Receiving) report, displays quantity of loads/total/units of product received from a 
selected customer in time frame selected.

Reports  » Receiving Usage 
Reports » By Truck...

Accesses the Usage By Truck (Receiving) report, displays quantity of loads/total/units of product received from a selected 
truck in time frame selected.

Reports  » Receiving Usage 
Reports » By Hauler...

Accesses the Usage By Hauler (Receiving) report, displays quantity of loads/total/units of product received from a selected 
hauler in time frame selected.

Reports  » Receiving Usage 
Reports » By Job/Customer...

Accesses the Usage By Job/Customer (Receiving) report, displays quantity of products, loads and total units received by 
job and customer.

Reports  » Receiving Usage 
Reports » By Job/Vendor...

Accesses the Usage By Job/Vendor (Receiving) report, displays quantity of products, loads and total units received by job 
and vendor.

Manage In-Process Trucks Opens a dialog box showing all in-process trucks, allowing the removal of them from the load stack.

Tools Menu Function
Export Transactions... Opens the Export Transactions wizard; exports selected criteria to an .XML file.
Export Transactions to CSV Opens the Export Transactions wizard; exports selected criteria to a CSV file.
Reprint Transaction Ticket Reprints the last transaction ticket.
Void Transaction... Opens the Void a Transaction dialog box, which allows a search for and void transactions.
Zero Scale One Zeros scale
Zero Scale Two Zeros scale

Options Accesses the Options dialog box, where application settings, scale settings, and ticket settings are set. See Section 3.0 on 
page 14 for more information.

Help Menu Function
Contents Opens this help file.
Reset Indicator 
Communications If communications with the indicator are lost, use this feature to reset them.

Unattended Kiosk Monitor Allows user to monitor communication with remote kiosk; troubleshoot communication and other issues
About Opens the About dialog box, displays program information.

File Menu Function

Table 2-1.  Menus and Functions (Continued)
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3.0 Setting Up OnTrak
Before using OnTrak, specify application settings, scale and communication options and ticket formatting preferences. 

3.1 Application Settings
1. Expand the Tools menu and select Options. The Options dialog box displays.
2. Expand the Application menu, if needed.

Figure 3-1. Options Dialog Box
3. Select Units. The units set on the indicator must match the units set in OnTrak. If they do not match, OnTrak’s readout 

displays: Indicator Sending Incorrect Units.
4. Expand the Units drop-down menu and select the units that match the indicator’s setting.

Figure 3-2. Select Units
5. Select Tare. Tare age determines the amount of time (in business days) before a stored tare expires, at which time a 

warning displays, alerting the operator of an expired tare.
6. Enter number of days desired, in the Tare Age text box, before a stored tare expires. Business days only, do not 

include weekends

Figure 3-3. Tare Age
7. Select Tare Scale. Settings under the Tare Scale selection apply to only two-scale systems. 
8. Select scale to be used to capture tare values.

Figure 3-4. Select Scale
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9. Select Tare Tolerance. Enable or disable the tare tolerance check box. If enabled, enter the desired tolerance value 
percentage.

Figure 3-5. Tare Tolerance
10. Select Scale Thresholds. Set the weight threshold that allows the operator to process a new transaction on the scale.
11. Enter the scale reset weight in the Scale Reset Weight text box.

Figure 3-6. Scale Threshold
12. Select Automated Kiosk.
13. Use the text boxes to enter the weight threshold that indicates that a truck is on the scale, and the maximum amount of 

time (in seconds) to wait for a value to be entered.

Figure 3-7. Automated Kiosk Settings.
14. Select Shipping/Receiving. 
15. From the Transaction Mode drop-down menu, select Shipping or Receiving to be the default transaction mode. This 

will determine which is selected automatically with each new transaction.

Figure 3-8. Shipping and Receiving
16. Using the radio buttons, select the mode used to calculate charges. Select:

• Shipping if there is a charge for product leaving the facility 
• Receiving if there is a charge for product entering the facility



OnTrak Truck Scale Data Management

16 Visit our website www.RiceLake.com

17. Select Weigh Screen.
18. Check or un-check the boxes to customize the appearance of the weigh screen.

Figure 3-9. Weigh Screen
19. Select Weigh Screen Overrides. Enable or disable check boxes to customize settings.

Figure 3-10. Weigh Scree Overrides
20. Select User Defined Transaction Fields.
21. Use the text boxes to label any user defined fields. Mark the check box to prompt for data on inbound and outbound 

weighments. 

Figure 3-11. User Defined Transactions

22. Press  when all application settings are set as desired.
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3.2 Scale Settings
OnTrak uses a one- or two-scale system. If using a two-scale system, both scales need to be configured. If using a one-scale 
system, ignore Scale Two options.

3.2.1 Scale One 
1. Expand the Tools menu and select Options. The Options dialog box displays.
2. Expand the Scale One menu.

Figure 3-12. Setup Dialog Box
3. Select Setup.
4. Expand the Scale One Driver menu and select the indicator connected to scale one.
5. Expand the Source Channel menu and select the desired channel to use.

IMPORTANT: Channel selection options vary depending on which indicator is selected in Step 4. If using an indicator with 
multiple channels, and a two-scale system, select one channel for scale one and a different channel for scale two.

6. Expand the Communications Method menu, select whether the indicator is connected via RS-232 or TCP/IP.
7. Enter the desired name for the scale in the Scale Label text box.
8. Select Communications.
9. Specify the correct communications options. The options available depend on whether RS-232 or TCP/IP are 

selected.

Figure 3-13. Communication Settings

  IMPORTANT: When configuring OnTrak with Virtui2, set the TCP Port to 20355 in the TCP/IP Options.

RS-232 Options

TCP/IP Options
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10. Select Kiosk. 
11. Check the box Enable Automated Kiosk for Scale One. 
12. Use the drop-down menus to specify the kiosk communications method, printer driver and Windows printer name.

Figure 3-14. Kiosk Configuration
13. Select Kiosk Communications. The options shown depend on the kiosk communications method selected.
14. Specify the correct communications options. The options available will depend on whether RS-232 or TCP/IP are 

selected.

Figure 3-15. Kiosk Communications Settings 

3.2.2 Scale Two
Follow the steps in Section 3.2.1 on page 17 for Scale Two setup.

3.3 Ticket Formatting
OnTrak supplies an editor to format the inbound and outbound tickets, as well as audits that can be set to print any additional 
information at weigh-out. Use the ticket editor’s tool bar buttons to insert pre-coded tokens or manually enter them using the 
tokens from Section 3.3.2 on page 20. 

Figure 3-16. Ticket Editors Tool Bar Icons

RS-232 Options

TCP/IP Options

1 2 3 4 5 6 7 8 9 10 11 12 13
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Table 3-1.  Ticket Editors Icon Inserts
To set the ticket format:

1. Expand the Tools menu and select Options. The Options dialog box displays.
2. Expand the Ticket Formatting menu.

Figure 3-17. Ticket Formatting
3. Select Receiving Inbound Format. The ticket editor displays.
4. Using the tool bar buttons, insert pre-coded variables as desired.
5. Press  to view how the ticket will look, a print preview box displays.

6. Press  to print the code.
IMPORTANT: Set the Receiving Outbound Ticket, Shipping Inbound, Shipping Outbound, and Audit Formats, using the 
same steps used to set Receiving Inbound Format.

3.3.1 Templates
To avoid building the same format each time it is needed, format templates can be saved and imported the next time it is 
needed. They can also be deleted once they are no longer useful.

• Use the drop-down menu to select a saved template. Press  to load it.

• Press  to save a template

• Press  to delete a template

Icon No. Inserts
1 Gross Weight
2 Tare Weight
3 Net Weight
4 Net Weight Alternate Units
5 Transaction Date and Time (use drop-down menu for more options)
6 Transaction Notes (use drop-down menu for more options)
7 Customer ID (use drop-down menu for more options)
8 Vendor ID (use drop-down menu for more options)
9 Product ID (use drop-down menu for more options)

10 Job ID (use drop-down menu for more options)
11 Truck ID (use drop-down menu for more options)
12 ASCII Character
13 Font Selection
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3.3.2 Ticket Formatting Tokens
Token Will insert...

<@nnn> ASCII character value in the ticket. Valid values for 'nnn' are between 0 and 255.
<ALTNETUNITS> Alternate Units
<ALTNETWGT> Net Weight Alternate Units (No Units)
<AMOUNTDUE> The amount due for this transaction
<CU> Customer ID, if applicable
<CUSTBILLADDRCITY> Customer Bill To Address City
<CUSTBILLADDRCOUNTRY> Customer Bill To Address Country
<CUSTBILLADDRLINE1> Customer Bill To Address Line 1
<CUSTBILLADDRLINE2> Customer Bill To Address Line 2
<CUSTBILLADDRLINE3> Customer Bill To Address Line 3
<CUSTBILLADDRPOSTAL> Customer Bill To Address Postal Code
<CUSTBILLADDRSTATE> Customer Bill To Address State/Province
<CUSTCONTACT> Customer Contact Name
<CUSTDISCNAME> Customer Discount Name
<CUSTDISCRATE> Customer Discount Rate
<CUSTFAX> Customer Fax
<CUSTNAME> Customer Name
<CUSTNOTES> Customer Notes
<CUSTPHONE> Customer Phone
<CUSTSHIPADDRCITY> Customer Ship To Address City
<CUSTSHIPADDRCOUNTRY> Customer Ship To Address Country
<CUSTSHIPADDRLINE1> Customer Ship To Address Line 1
<CUSTSHIPADDRLINE2> Customer Ship To Address Line 2
<CUSTSHIPADDRLINE3> Customer Ship To Address Line 3
<CUSTSHIPADDRPOSTAL> Customer Ship To Address Postal Code
<CUSTSHIPADDRSTATE> Customer Ship To Address State/Province
<DA> Transaction Date in the format of 'MM/dd/yy'
<DA4> Transaction Date in the format of 'MM/dd/yyyy'
<DELIVERYADDRCITY> Delivery Address City
<DELIVERYADDRCOUNTRY> Delivery Address Country
<DELIVERYADDRLINE1> Delivery Address Line 1
<DELIVERYADDRLINE2> Delivery Address Line 2
<DELIVERYADDRLINE3> Delivery Address Line 3
<DELIVERYADDRPOSTAL> Delivery Address Postal Code
<DELIVERYADDRSTATE> Delivery Address State/Province
<HAULERADDRCITY> Hauler Address City
<HAULERADDRCOUNTRY> Hauler Address Country
<HAULERADDRLINE1> Hauler Address Line 1
<HAULERADDRLINE2> Hauler Address Line 2
<HAULERADDRLINE3> Hauler Address Line 3
<HAULERADDRPOSTAL> Hauler Address Postal Code
<HAULERADDRSTATE> Hauler Address State/Province
<HAULERCONTACT> Hauler Contact Name
<HAULERFAX> Hauler Fax
<HAULERNAME> Hauler Name
<HAULERPHONE> Hauler Phone
<ID> Truck ID
<JB> Job ID, if applicable
<JOBCLOSED> Indicates CLOSED if the job is closed, blank if not.
<JOBDAILYTOTAL> The amount of product delivered on the job for the current day.
<JOBDELIVERED> The amount of product remaining on the job for the product specified in the transaction.
<JOBNAME> Job Name

Table 3-2.  Ticket Formatting Tokens
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<JOBNOTES> Job Notes
<JOBORDERED> The amount of product remaining on the job for the product specified in the transaction.
<JOBREMAINING> The amount of product remaining on the job for the product specified in the transaction.
<NLxx> New Line (carriage return and line feed) (xx = number of spaces; i.e., <NLxx> would insert two new lines).
<NONTAXABLECHARGES> The list of non-taxable charges. This includes charges from Customer, Product, and Job.
<NONTAXABLESUBTOTAL> The subtotal of non-taxable charges
<NP> Calculated Net Product Price, adjusted for special job pricing and customer discount, if applicable.
<PR> Product ID, if applicable
<PRODDESC> Product Description
<PRODMINCHARGE> Product Minimum Charge
<PRODNAME> Product Name
<PRODNOTES> Product Notes
<PRODPRICE> Product List Price
<PRODPRICEUNIT> Product Price Unit of Measure
<SP> Space
<SPxx> Multiple spaces (xx = number of spaces; i.e., <SPxx> would insert two spaces).
<TAXABLECHARGES> The list of taxable charges. This includes charges from Customer, Product, and Job.
<TAXABLESUBTOTAL> The subtotal of taxable charges.
<TAXES> The list of taxes
<TAXSUB> The subtotal of taxes
<TD> Transaction Time and Date in the format of 'h:mm AM/PM MM/dd/yy'
<TD4> Transaction Time and Date in the format of 'h:mm AM/PM MM/dd/yyyy
<TDL> Transaction Time and Date formatted per Windows Short Time and Short Date regional settings.
<TI> Transaction Time in the format of 'h:mm AM/PM'
<TR1> Truck Gross Weight
<TR1WGT> Truck Gross Weight (No Units)
<TR2> Truck Tare Weight (Includes KEYED, RECALLED, and INBOUND as appropriate).
<TR2WGT> Truck Tare Weight (No Units)
<TR3> Truck Net Weight
<TR3WGT> Truck Net Weight (No Units)
<TRAILER1ID> Trailer 1 ID
<TRAILER2ID> Trailer 2 ID
<TRAILER3ID> Trailer 3 ID
<TRANID> Transaction ID
<TRANSNOTES> Transaction Notes
<TRUCKNAME> Truck Name
<TRUCKTAREACQ> Truck Tare Acquired Date
<TRUCKTAREEXP> Truck Tare Expiration Date
<USER> The name of the user/operator that performed the transaction.
<UFL1> User Field Label 1
<UFL2> User Field Label 2
<UFL3> User Field Label 3
<UFD1> User Field Data 1
<UFD2> User Field Data 2
<UFD3> User Field Data 3

Token Will insert...

Table 3-2.  Ticket Formatting Tokens (Continued)
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3.4 Ticket Printing
Specify what type of printer (Windows printer or serial printer) being using. If using a serial printer, also specify its 
communication settings. Different printers can be set for the tickets and audits.

Figure 3-18. Ticket Printer Screen
1. Expand the Tools menu and select Options. The Options dialog box displays.
2. Expand the Ticket Printing menu and select Ticket Copies.
3. Enter the number of weight tickets to print. 
4. Check the box to print inbound tickets, if needed.
5. Select Ticket Printer.

Figure 3-19. Ticket Printer Settings
6. Expand the Printer Driver menu and select either the Windows printer (Windows Printer Driver) or a serial printer 

(Generic Serial Printer Driver).
7. For a Windows printer, expand the Windows Printer Name menu to select a printer. All printers installed on the 

computer are listed. Skip to Step 10 on page 22.
For a serial printer, expand the Communications Method menu and select whether it is connected via RS-232 or 
TCP/IP.

8. For a serial printer, select Ticket Printer Communications.
9. Specify the correct communications options. The options available will depend on whether RS-232 or TCP/IP are 

selected.

Figure 3-20. Communication Settings
10. Select Audit Printer.

RS-232 Options

TCP/IP Options
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11. Expand the Printer Driver menu and select either the Windows printer (Windows Printer Driver) or a serial printer 
(Generic Serial Printer Driver).

12. If using a Windows printer, expand the Windows Printer Name menu to select a printer. All printers installed on the 
computer are listed. Skip to Step 15.
If using a serial printer, expand the Communications Method menu, select whether it is connected via RS-232 or TCP/
IP.

13. If using a serial printer, select Audit Printer Communications.
14. Specify the correct communications options. The options available will depend on whether RS-232 or TCP/IP are 

selected.

Figure 3-21. Communication Settings

15. Press  when all application settings are set as desired.

3.5 Creating Users and Permissions
When logged in as the administrator, create new users and set their permissions as having either administrator or user rights. 
User rights disable all features except for making a weighments. Table 3-3 contains the default administrator login. To change 
the password, see Section 3.5.2 on page 24.

3.5.1 Creating a New User and Setting Their Permissions
1. Expand the View menu and select Users. Or press the Users icon on the tool bar. The Users dialog box displays.
2. Press . The Edit User dialog box displays.

Figure 3-22. Edit User Dialog Box

User name Administrator
Password password

Table 3-3.   Default Administrator Login.

RS-232 Options

TCP/IP Options
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3. Type a name in the User Name text box. This will be the user’s log-in name.
4. Press  to assign a password. The Set Password dialog box displays.
5. Enter the desired password in the New Password text box and enter the same password in the Confirm Password text 

box.
6. Press .
7. Check the box in the Roles section to the desired permissions. 
8. Ensure there are no errors in the Broken Rules section.
9. Press . 

10. Press  to return to the main screen.

3.5.2 Changing a Password and Permissions
OnTrak allows a user’s permissions and/or password to be changed. The user name cannot be modified; a new one must be 
created.

1. Expand the View menu and select Users or press the Users icon on the tool bar. The Users dialog box displays.
2. Select the user name to modify.
3. Press . The Edit User dialog box displays.

4. Press  to assign a new password. The Set Password dialog box displays.
5. Enter the desired password in the New Password text box and enter the same password in the Confirm Password text 

box.
6. Press .
7. Check the box next to the desired permissions, in the Roles section.
8. Press . 

9. Press  to return to the main screen.

3.5.3 Deleting a User
1. Expand the View menu and select Users or press the Users icon on the tool bar. The Users dialog box displays.
2. Select the user name to delete.
3. Press . A confirmation dialog box appears.
4. Press Yes to delete, the user name no longer appears in the list.
5. Press  to return to the main screen.
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4.0 Creating and Modifying Database Information
OnTrak’s database allows the storage of information for customers, products, haulers, trucks, jobs and discounts. The system 
must be logged in as a user with administrator permissions to create or modify database information. 
When creating or modifying database information, a consistent element of the dialog boxes is the Broken Rules section. When 
modifying database information, the Search function can be used. These two features are described below.

Broken Rules Section
This appears in any dialog box where database information is entered. 
The Broken Rules section displays error messages during database information creation.

Figure 4-1. Customer Dialog Box

Search Function
When making a selection from the View menu (excluding Users), a dialog box similar to that shown in Figure 4-2 will appear. To 
quickly locate an item, it is recommended to use the Search function. To do so, in the Search Text text box, type a keyword 
matching the item to retrieve and press the Search button. This will display only items matching the keyword. To view all items 
(e.g., all customers), leave the Search Text text box blank and press the Search button. Doing so may be a time-consuming 
operation the database is large.

4.1 Creating a New Customer
1. Log in as an administrator. See Section 2.1.1 on page 11.
2. Press the Customer icon from the tool bar or select View and press Customers. The Select Customer dialog box 

appears.

Figure 4-2. Customer Dialog Box
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3. Press . The Edit Customer dialog box appears.

Figure 4-3. Edit Customer Dialog Box.
4. Fill in the text boxes as appropriate for the customer.
5. To create a custom inbound or outbound ticket for this customer, press the Inbound Ticket or Outbound Ticket buttons, 

respectively. Refer to Section 3.3 on page 18 for information on ticket formatting.
6. To apply a discount, select it from the Discount drop-down menu.

NOTE: The discount must already be entered for it to be in the list. See Section 4.7 on page 33 for adding discounts and 
Section 4.8 on page 34 for information on modifying the database.

7. To add charges to this customer, select the Charges tab.

Figure 4-4. Charges Tab

8. Press .The Edit Charge dialog box appears. 

Figure 4-5. Edit Charge dialog box.

9. Complete the dialog box as appropriate and press . The charge now appears in the Charges section.

10. When all information is entered as desired, press . The customer is added to the database and appears 
in the Select Customer dialog box.

11. To return to OnTrak, press .

Acme Company

PO Box 1234
Rice Lake, WI 54868
USA

1234 Main St
Rice Lake, WI 54868
USA

John Doe

715-555-1234

715-555-5678
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4.2 Editing Vendors
1. Log in as an administrator.
2. Press the Vendor icon from the tool bar or select View and press Vendors. The Vendor dialog box displays.

Figure 4-6. Vendors Dialog Box

3. Press . The Edit Vendor dialog box displays.
4. Fill in the text boxes as appropriate for the customer.

This box allows for a vendor to be added, edited/viewed and deleted. Follow the prompts in each section.

4.3 Adding Product
1. Log in as an administrator.
2. Press the Products icon from the tool bar or select View and press Products. The Products dialog box displays.

Figure 4-7. Products Dialog Box
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3. Press . The Edit Products dialog box appears.
4. Fill in the text boxes as appropriate for the customer.

Figure 4-8. Edit Product Dialog Box
5. Enter an ID in the Product ID text box
6. Enter the product’s name in the Name text box.
7. Enter the price in the Price text box and select the unit of measure.
8. Enter a minimum charge, if needed, in the Minimum Charge text box.
9. Enter the product description in the Description text box, if needed.
10. Add any applicable notes to the product by pressing the Notes button.
11. If there are any charges to be attached to this product, in the Charges section press . The Edit Charge 

dialog box appears.

Figure 4-9. Edit Charge Dialog Box

12. Complete the dialog box as appropriate and press . The charge now appears in the Charges section.

13. When all information is entered as desired, press . The product is added to the database and appears 
in the Select Product dialog box.

14. To return to OnTrak, press .
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4.4 Creating a New Hauler
1. Log in as an administrator. See Section 2.1.1 on page 11.
2. Press the Haulers icon from the tool bar or select View and press Haulers. The Haulers dialog box displays.

3. Press . The Edit Hauler dialog box appears.

Figure 4-10. Edit Hauler dialog box.
4. Enter the haulers name in the Name text box.
5. Press the Address button and enter the hauler’s address.
6. Enter the hauler’s phone and fax numbers into the Phone and Fax text boxes.
7. If there are any charges to be attached to this hauler, in the Charges section press . The Edit Charge 

dialog box appears.

Figure 4-11. Edit Charge dialog box.

8. Complete the dialog box as appropriate and press . The charge now appears in the Charges section.

9. If there are any trucks to be attached to this hauler, in the Trucks section press . The Edit Truck dialog 
box appears.

10. Complete the dialog box as appropriate. See Section 4.5 on page 30 for information on the Edit Truck dialog box.
11. When the Edit Truck dialog box is complete, press . The truck now appears in the Trucks dialog box.

12. To return to OnTrak, press .
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4.5 Creating a New Truck
Trucks can be assigned to a hauler. A new truck can be created during the hauler creation process, or it can create a new truck 
in its own process, during which pre-existing hauler is assigned.

1. Log in as an administrator. See Section 2.1.1 on page 11.
2. Press the Trucks icon from the tool bar or select View and press Trucks. The Trucks dialog box displays.
3. Press . The Edit Trucks dialog box appears.

Figure 4-12. Edit Truck dialog box, General tab.
4. From the General tab, enter the truck ID, truck name, minimum weight and maximum weight. Use the Hauler drop-

down menu to select the corresponding hauler, and use the Insurance Expiration drop-down menu to select the date of 
insurance expiration.

NOTE: The truck’s radio tag ID and is currently not used in this version; it is for future purposes.
Entering the truck’s minimum/maximum weights is optional. If the truck is not currently in use, mark the Inactive check 
box; if it is a short-term truck, select the Transient check box.

5. Select the Tare tab.

Figure 4-13. Edit Truck Dialog Box, Tare Tab
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6. From the Tare Type drop-down menu, select Keyed to type the truck’s tare value; select Weighed for weigh-in/weigh-
out functionality; select Stored if the truck is on the scale and the Acquire Tare button is to be pressed to acquire the 
tare now.

NOTE: The Tare expiration drop-down menu displays the tare’s expiration date. This is calculated based on the application 
settings. Refer to Section 3.1 on page 14 for information on setting the tare age.

7. Select the Defaults tab. 
Information specified in the Defaults tab will automatically appear when the corresponding truck is selected from the 
main screen. This is helpful if a truck is consistently working for the same customer, carrying the same product, or 
working on the same job.

Figure 4-14. Edit Truck Dialog Box, Defaults Tab
8. Using the drop-down menus, select a default customer, default product and/or a default job.
9. When the Edit Truck dialog box is complete, press . The truck now appears in the Trucks dialog box.

10. To return to OnTrak, press .
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4.6 Creating a New Job
Jobs provide another level of organization and pricing control within OnTrak. If there are multiple haulers all working on the 
same job, such as a major highway construction, or if one hauler is working on multiple jobs, creating each job in OnTrak allows 
tracking of where products are going and view overall totals. Special pricing and/or charges can also be specified for the job.

1. While logged in as an administrator, from the View menu or the tool bar, select Jobs. The Select Job dialog box 
appears and offers the same features as the Select Customer dialog box shown in Figure 4-2 on page 25.

2. Press . The Edit Job dialog box appears.

Figure 4-15. Edit Job Dialog Box
3. Complete the dialog box as appropriate.
4. To specify special pricing for the job, in the Special Pricing section press . The Edit Job Pricing dialog 

box appears.

Figure 4-16. Edit Job Pricing Dialog Box
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5. Complete the dialog box and press . The pricing now appears in the Special Pricing section.

6. If there are any charges to be attached to this job, in the Charges section press . The Edit Charge 
dialog box appears.

Figure 4-17. Edit Charge dialog box.

7. Complete the dialog box as appropriate and press . The charge now appears in the Charges section.
8. Any errors regarding the information entered (i.e., a name with too many characters) will appear in the Broken Rules 

section of the dialog box.
9. When all information is entered as desired, press . The job is added to the database and appears in the 

Select Job dialog box.
10. To return to OnTrak, press .

4.7 Creating a New Discount
If running special discounts, or there is an agreement with a certain customer for a discount, it can be easily added to OnTrak.

1. While logged in as an administrator, from the View menu or the tool bar, select Discounts. The Discounts dialog box 
appears, and offers the same features as the Select Customer dialog box shown in Figure 4-2 on page 25.

2. Press . The Edit Discount dialog box appears.

Figure 4-18. Edit Discount dialog box.
3. In the Name text box, type a name to identify the discount.
4. In the Rate text box, type the rate as a percentage (i.e., 25.00 would equal 25% off the product price).
5. When the Edit Discount dialog box is complete, press . The discount now appears in the Discounts 

dialog box.
6. To return to OnTrak, press .
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4.8 Modifying Database Information
If any information regarding customers, products, haulers, trucks, jobs or discounts needs to be changed, it is simple to do so.

1. From the View menu, select which category contains the information to be modified. A corresponding dialog box 
appears. Each category follows the same procedure. For this example, we will modify a product, so the Select Product 
dialog box appears.

2. In the Search Text text box, type a keyword that will match the desired product. This is helpful if it is a large database. 
To view all products in the database, leave the Search Text text box blank.

3. Press Search. Products matching the keyword, or all products, are retrieved and appear in the Products section.

Figure 4-19. Modify Database
4. If more than one product is retrieved, select the desired item from the Products list.
5. Press Edit/View. The Edit Product dialog box appears. This is the same dialog box that appeared when creating the 

item. Refer to creation instructions for more information on filling out the dialog box.
6. Make any desired changes.
7. When all changes have been made, press . The item is updated.

8. To return to OnTrak, press .

4.9 Deleting Database Information
1. From the View menu, select which category contains the information to be deleted. A corresponding dialog box 

appears. Each category follows the same procedure. For this example, a truck will be deleted, so the Trucks dialog 
box appears.

2. In the Search Text text box, type a keyword that matches the desired product. This is helpful if it is a large database. To 
view all items (in this case, trucks) in the database, leave the Search Text text box blank.

3. Press Search. Items matching the keyword, or all items, are retrieved and appear in the Trucks section.
4. If more than one truck is retrieved, select the desired item from the Trucks list.
5. Press Delete. A confirmation dialog box appears.
6. Press Yes.
7. To return to OnTrak, press .
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5.0 Making Weighments
Weighments in OnTrak can be made manually through the program’s main screen. Select to enter shipping or receiving mode, 
as well as the truck, job, customer and product. Refer to Section 3.1 on page 14 for instructions on shipping and receiving 
modes.

Figure 5-1. OnTrak Truck Scale Data Management Main Screen

Select Shipping or Receiving 
Transaction Mode

Truck, Job, Customer and 
Product Selections

Menu bar

Tool bar
Weigh button performs 
weigh-ins and weigh-outs

Virtual Indicator

Trucks that have been weighed in (but not weighed out) appear in 
this section. Select one and press the Weigh button to weigh out.

Red light means load is stable
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5.1 Automated Kiosk Mode
Weighments can automatically be made by enabling automated kiosk mode. First, automated kiosk mode must be configured 
See Section 3.1 on page 14, then it can be enabled on scale one, scale two, or both. To enable automated kiosk mode:

1. From the Tools menu, select Options. The Options dialog box displays.
2. Select the Scale One or Scale Two options by double-clicking the folder.
3. Under Scale One or Scale Two, press Kiosk. Ensure the correct communications method is specified, as well as the 

printer driver and Windows printer name. Mark the Enable Automated Kiosk check box.

Figure 5-2. Kiosk Configuration Settings

4. Under Scale One, select Kiosk Communications. The right pane’s options will depend on the kiosk communications 
method selected in Step 3.

5. If TCP/IP was selected for the kiosk communications method in Step 3, specify the IP address and TCP port.

Figure 5-3. Kiosk Communications Settings. TCP/IP (Left) RS-232 (Right)

6. If RS-232 was selected for the kiosk communications method in Step 3, use the drop-down menus to specify the 
communications port, data bits, stop bits, baud rate, and parity.

7. To begin automated kiosk mode, press .
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5.2 Manual Weigh-Ins
Before weigh-in of a truck, the truck must already be entered in the OnTrak database. Customer, product and job information 
may also be entered, but are not required. Refer to Section 4.0 on page 25.

1. From the OnTrak main screen, select either shipping mode or receiving mode.
NOTE: Shipping mode is used when product is leaving the facility.
Receiving mode is used when product is coming in.

2. From the Truck drop-down menu, select the customer’s truck that is being used.
3. If this weighment relates to a specific job, from the Job drop-down menu, select the applicable job.
4. From the Customer drop-down menu, select the appropriate customer.
5. From the Product drop-down menu, select the product being weighed.
6. Have the truck drive onto the scale. The light next to the standstill annunciator on the virtual indicator turns gray when 

the load is in motion and red when the load is stable and ready for weighment.
7. Press Weigh. The transaction is added to the Load Stack (In-Process Trucks) section of the screen.

  NOTE: To add any applicable notes about the weighment, press the Notes button.

5.3 Manual Weigh-Outs
When the truck is ready to be weighed out, 

1. If the truck has been weighed in (and a tare has been acquired from the scale), select the truck from the Load Stack 
(In-Process Trucks) section and press Weigh. The weighment is complete and the ticket (audit information that has 
been set up) is printed.

2. If using a keyed or stored tare, the truck will not appear in the Load Stack (In-Process Trucks) section. The ticket (audit 
information that has been set up) will be printed.

NOTE: If a truck has been weighed in and cannot be weighed out, ensure its tare is set to Weighed. To delete a truck from 
the load stack, refer to Section 5.4. If indicator communications are lost, refer to Section 8.3 on page 50.

5.4 Managing In-Process Trucks
If a truck has been weighed in, to delete it from the load stack (in-process trucks grid):

1. From the View menu, select Manage In-Process Trucks. The In-Process Trucks dialog box displays, listing all trucks 
in the grid.

2. Press the Delete button. A confirmation dialog box appears. 
3. Press Yes to remove the truck from the load stack (in-process trucks grid).
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6.0 Automated Weighing
The 920i OnTrak Automated Weighing Kiosk is supported by the OnTrak truck weighing application. It communicates with 
OnTrak for all required information. The software may be loaded into a single kiosk (outbound) for a single-direction truck scale 
application or it may be loaded into two kiosks (inbound/outbound) to support dual-direction automated weighing.

  IMPORTANT: After a successful download, the 920i needs to be power cycled. 

6.1 Operation Sequence
The 920i displays the [] – [] – [] – [] – [Setup Menu] softkeys and welcome message when it powers up or exits the configuration 
or setup menus.

• When connection between the OnTrak Automated Weighing Kiosk and OnTrak is broken or lost, the 920i will display 
Unable to process truck. See attendant for help.

• When the connection between the OnTrak Automated Weighing Kiosk and the printer is broken or lost, the 920i will 
display Error: Printer Communication.

• If the printer is enabled in the set up menu and goes off line, the 920i will not continue to run normally.

Figure 6-1. Broken or Lost Connection Display

6.2 Processing a Truck
1. Ensure the scale is empty and zeroed with a GREEN traffic light.
2. Drive onto the scale. The traffic light turns RED. The 920i display reads Please enter your Truck ID.

NOTE: If the traffic light does not turn to RED when a truck is on the scale, adjust the threshold weight within the OnTrak 
software. 

3. Enter the truck ID by using the numeric keypad/keyboard, scanning an HID RFID card, or by scanning a SmartPass 
RF tag.

NOTE: If using the HID or the SmartPass RFID, the tag/card number must be entered in the Radio Tag ID field in the trucks 
database in the OnTrak software. Port 1 must also be configured for the correct device in the setup menu. 
Port 1 baud rate settings need to be set appropriately for the attached device in the 920i configuration menu (not the 
software setup menu).
4.  The 920i queries OnTrak to search the truck’s SQL database for the entered ID. 

• Truck/Radio Tag ID FOUND – Proceed to the next prompt.
• Truck/Radio Tag ID FOUND without additional prompts – Proceed to complete weighment.
• Truck ID NOT FOUND – The 920i displays Truck ID was not found. Try again or see attendant for help.

5. Enter valid ID or exit the scale. If the driver does not exit the scale, the prompt will time out and revert back to the 
Please enter your Truck ID prompt. When this occurs, it is normal for the traffic light to turn GREEN momentarily while 
the prompt is reset. 
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6.3 Processing a Truck with Loop Detectors
1. Ensure the scale is empty and zeroed with a RED traffic light. Double zeros show on the kiosk and remote displays 

(OnTrak will still show weight). Drive onto the approach, driving over the loop detector. The OnTrak Automated 
Weighing Kiosk will attempt to zero the scale. The system performs one of the following actions:
• Scale Zeroed – Traffic light turns GREEN, program continues to Step 3.
• Scale not Zeroed – Displays continue to show the RED traffic light and double zeros. The truck must back off the 

approach and continue from the beginning of Step 2. 
2. Drive onto the scale. The traffic light turns to RED. The 920i displays Please enter your Truck ID.

NOTE: If the traffic light does not turn to RED when a truck is on the scale, adjust the threshold weight within the OnTrak 
software. 

3. Enter the truck ID by using the numeric keypad/keyboard, scanning an HID RFID card, or by scanning a SmartPass 
RF tag.

NOTE: If using the HID or the SmartPass RFID the tag/card number must be entered in the Radio Tag ID field in the trucks 
database in the OnTrak Software. Port 1 must also be configured for the correct device in the setup menu. 
Port 1 baud rate settings need to be set appropriately for the attached device in the 920i configuration menu (not the 
program setup menu).

4.  The 920i queries OnTrak to search the truck’s SQL database for the entered ID. 
• Truck/Radio Tag ID FOUND – Proceed to the next prompt.
• Truck/Radio Tag ID FOUND without additional prompts – Proceed to complete weighment.
• Truck ID NOT FOUND – The 920i displays Truck ID was not found. Try again or see attendant for help. 

IMPORTANT: Enter valid ID or exit the scale. If the driver does not exit the scale, the prompt will time out and revert back to 
the Please enter your Truck ID prompt. When this occurs, it is normal for the traffic light to turn GREEN momentarily while 
the prompt is reset. 

6.4 Additional Prompts
Prompts vary depending on how the truck is configured in the OnTrak program. The 920i may prompt the user for the following:

6.4.1 Entering a Job ID
1. The 920i prompts driver for job ID.

• If a vendor is selected in the default tab for the entered truck ID, the 920i displays Please enter your Job ID or leave 
blank to skip.

• If a vendor is not selected in the default tab, the 920i displays Please enter your Job ID.
2. Enter Job ID and press Enter.

• If the job ID is found and there are additional prompts, proceed to the next prompt. 
• If the job ID is found and there are no additional prompts, proceed to Complete Weighment. 
• If the job ID is not found, the 920i displays Job ID was not found, try again or see attendant for help. Enter a valid job 

ID, seek an attendant for help, or press Enter to skip the prompt and proceed to the next one.

6.4.2 Entering a Product ID
1. The 920i prompts driver for product ID.

• The 920i displays Please enter your Product ID.
2. Enter product ID and press Enter.

• If product ID is found and there are additional prompts, proceed to the next prompt.
• If product ID is found and there are no additional prompts, proceed to complete weighment.
• If product ID is not found the 920i displays Product ID was not found, try again or see attendant for help. Enter a 

valid product ID, seek an attendant for help, or drive off the scale without completing the transaction. 
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6.4.3 Entering a user Field (1-3)
1. The 920i prompts driver for user field.

• The 920i displays Please enter {User Field Name}.
2. Enter user field ID and press Enter.

• If there are additional prompts, proceed to the next prompt.
• If there are no additional prompts, proceed to complete weighment. 

6.4.4 Complete Weighment
The system performs the following actions:

• The 920i displays Processing, Please Wait.
• If the truck insurance in the OnTrak Software is expired, the 920i displays Truck insurance has expired. See 

attendant for help. If the truck insurance has not expired, it will proceed to the next step.
• The 920i captures the stable gross weight and sends it to OnTrak.
• The OnTrak software will calculate gross, tare and net based on the captured gross weight and the recalled inbound 

weight. The software will perform value swapping if necessary.
• The software stores the transaction to the OnTrak SQL Database.
• The system prints a ticket.
• The 920i displays Transaction Complete.Take ticket and exit scale. When the scale weight drops below threshold, 

the 920i returns to Step 1 on page 32.

Figure 6-2. Connection is Broken or Lost

NOTE: The OnTrak Automated Weighing Kiosk will never prompt for customer or vendor. Customers and vendors will be 
tied to a specific truck for shipping/receiving mode.
The OnTrak Software has a Virtui driver. A Virtui license will be supplied to users with their purchase of an OnTrak license if 
they are using an iQube2 with the Automated Weighing Kiosk system. 
Loop detectors will not be supported if the A/D that OnTrak is getting weight from is NOT located in the Automated 
Weighing Kiosk because it will not have a way to zero the scale. 
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6.5 Application Setup & Configuration
The setup menu softkey is password-protected and offers access to the following:

• Display program name and version
• Display a weight widget

Table 6-1.  Setup and Configuration Parameters

6.6 Hardware Setup
The hardware setup for the outbound and inbound kiosks.

6.6.1 Outbound Kiosk

Parameter Default Softkey Description
System Time and Date Current Time/Date Time and Date of the 920i

System Password “” Setup Password
Changing the password that is required for entry in the setup menu; setting the pass-
word to nothing will cause the system to not prompt for a password when the setup 
menu softkey is pressed

OnTrak Timeout 30 Seconds OnTrak Timeout Allows user to define how long to wait for customer entry before system resets the 
prompt back to Enter Truck ID

Printer Enabled/Disabled Enabled Printer Enabled/
Disabled

Allows the user to enable or disable the monitoring of the printer DTR line; when 
enabled, the program displays Error: Printer Communication and inhibits truck pro-
cessing when the printer goes off-line

Setup Serial Port 1 HID Reader Setup Port 1
Allows operator to change the device connected to serial port 1; operator must manu-
ally change the baud rate in the 920i configuration menu to match the baud rate set-
tings of the device connected

Inbound Kiosk/ Outbound Kiosk Outbound Inbound/Out Allows operator to tell OnTrak if the kiosk is the inbound kiosk or the outbound kiosk

Loop Detectors On or Off Off Loops On/Off Allows operator to turn the loop detector functionality on or off 
Note: If there is no A/D detected in the 920i, this softkey will not be available 

Slot Type
1 Dual Channel Serial Card
2 1Mb Memory Card
3 Currently Not Used (Optional A/D Card)
4 Currently Not Used

Table 6-2.  Option Card 

Slot Bit Type Function
0 1 Output Red Light Control
0 2 Output Green Light Control
0 3 Input Loop Detector 1 (Optional)
0 4 Input Loop Detector 2 (Optional)
0 5-6 Off Currently Not Used

Table 6-3.  Digital I/O 
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6.6.2 Inbound Kiosk

Port Type Description Setup
1 PROGIN RFID Reader 57600,8,E,2
2 KEYBRD Qwerty Kiosk Keyboard 115200,8,N,2
3 PROGIN Numeric Keypad/Remote Display 9600,8,N,2
4 CMD Inbound Kiosk 9600,8,N,2
5 PROGIN Epson EU-T482 Printer 9600,8,N,2
6 CMD PC Connection (Kiosk Communication) 9600,8,N,2

Table 6-4.  Serial Port 

Slot Type
1 Dual Channel Serial Card
2 1Mb Memory Card
3 Currently Not Used (Optional A/D Card)
4 Currently Not Used

Table 6-5.  Option Card 

Slot Bit Type Function
0 1 Output Red Light Control
0 2 Output Green Light Control
0 3-6 Off Currently Not Used

Table 6-6.  Digital I/O 

Port Type Description Setup
1 PROGIN RFID Reader 57600,8,E,2
2 KEYBRD Qwerty Kiosk Keyboard 115200,8,N,2
3 PROGIN Numeric Keypad/Remote Display 9600,8,N,2
4 CMD Currently Not Used 9600,8,N,2
5 PROGIN Epson EU-T482 Printer 9600,8,N,2
6 CMD Outbound Kiosk 9600,8,N,2

Table 6-7.  Serial Port 
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7.0 Reports
OnTrak can generate several reports based on which information to be viewed. To access reports, log in as a user with 
administrator permissions.
The reports include:

• Customer Report
• Hauler Report
• Product Report
• Truck Report
• Job Report
• Discounts Report
• Shipping Transactions
• Receiving Transactions
• Shipping Usage Reports (by product, customer, truck, hauler or job)
• Receiving Usage Reports (by product, customer, truck, hauler or job)

These reports can be viewed, printed or exported. Within the report, export options include Microsoft Excel format (.xls), or 
Acrobat (.pdf) format. Access to the Export Transactions wizard (Tools » Export Transactions...) to export transactions (based 
on selected criteria) to an .XML file is accessible.

7.1 Viewing and Printing a Report
1. Log in as an administrator. See Section 2.1.1 on page 11.
2. Expand View and select Reports. The process is the same for all reports except transaction reports. The report dialog 

box displays. Customer is being used for examples.

Figure 7-1. Example Dialog Box – Customer Report

3. In the Search Text text box, type a keyword to identify the customer. 
This text box can be left empty, but this will create a report of all customers and may be a lengthy process depending 
on the size of the database.

Figure 7-2. Report Length Awareness

  NOTE: Recent keyword searches will appear in the Search Text drop-down menu.
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4. Press . The Customer Report dialog box generates the customer report.

Figure 7-3. Customer Report

5. To print the report, press  on the tool bar. The printer selection box displays.

6. Select a printer and press .

7.2 Viewing/Printing a Transaction Report
Transaction reports are added to the database frequently. When searching for them, use keywords and dates to locate and 
view/print specific transactions.

1. Log in as an administrator. See Section 2.1.1 on page 11.
2. Expand View and select Reports. The process is the same for shipping and receiving reports. The transaction dialog 

box displays. Shipping Transactions are being used for examples.

Figure 7-4. Shipping Transactions Report

Report Tool Bar
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3. Enter information into the text boxes or enter keywords to identify the transaction. A date range can also be specified. 
Leaving the other text boxes blank, use the drop-down menus for Start Date and End Date to set dates. 

NOTE: The Start Date and End Date range is always in effect. The other text boxes are optional criteria that can be used to 
further refine the search. All transactions occurring within a selected date range will appear if no keywords are entered in 
the Search text boxes.
Shipping or Receiving transactions occurring within a selected date range will appear if no keywords are entered in the 
Search text boxes.

4. Press . The transaction report is generated.

5. To print the transaction report, press  on the tool bar. The printer selection box displays.

6. Select a printer and press .

7.3 Exporting a Report
After a report is generated, it can be exported to one of the following file types:

• Microsoft Excel (.xls)
• Microsoft Word (.doc)
• Acrobat (.pdf)
• Extensible Markup Language (.XML)
• Comma Separated Value (.CSV)

7.3.1 Export to Microsoft or Acrobat
Use the following steps to export a report to a Microsoft Excel (.xls), Microsoft Word (.doc) or Acrobat (.pdf) file type. 

1. Generate a report (see Section 7.1 on page 43).
2. Press the save icon on the report tool bar. The files types are displayed.

Figure 7-5. Export Drop-Down Menu

3. Select the desired file type.
4. Navigate to the desired save location and enter a file name.
5. Press . The file saves in the selected location.
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7.3.2 Export to an .XML File 
Use the following steps to export a report to an .XML file. 

Figure 7-6. Export Transactions Wizard

1. Expand the Tools menu and select Export Transactions. The Export Transactions wizard displays. 

Figure 7-7. Export XML Transactions

2. Use the drop-down menus to select desired criteria for each item. Leave a field blank to include all of its database 
entries.

3. Press . The date range dialog box displays.

Figure 7-8. Date Range Dialog Box
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4. Enter the Start Date and End Date by pressing the arrow at the end of the date fields.
5. Press . 

Figure 7-9. Export Destination

6. Press . A file save box displays.

7. Enter a file name for the export and press . The data is exported to an .XML file at the location specified.

7.3.3 Export to a .CSV File
Use the following steps to export a report to a .CSV file. 

Figure 7-10. Export Transactions Wizard

1. Expand the Tools menu and select Export Transactions to .CSV File. The Export Transactions wizard displays. 

Figure 7-11. Export XML Transactions

2. Use the drop-down menus to select desired criteria for each item. Leave a field blank to include all of its database 
entries.
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3. Press . The date range dialog box displays.

Figure 7-12. Date Range Dialog Box

4. Enter the Start Date and End Date by pressing the arrow at the end of the date fields.
5. Press . The template dialog box displays.

Figure 7-13. Template Dialog Box

6. Select the fields to transport using the export fields tool bar or load a saved template by selecting it from the drop-down 
menu and pressing . The export destination box displays.

Figure 7-14. Export Destination

7. Press . A file save box displays.

8. Enter a file name for the export and press . The data is exported to a .CSV file at the location specified.

Export Fields 
Tool Bar
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8.0 Maintenance
OnTrak uses the Database Backup Restore Utility to backup and restore databases. It is recommended to make regular 
backups of the database.

8.1 Backing up a Database
1. Open the Database Backup Restore Utility (Start » Programs » Rice Lake Weighing Systems » OnTrak » Database 

Backup Restore Utility).

Figure 8-1. OnTrak Database Maintenance

2. Press .

Figure 8-2. 

3. Press  and navigate to the desired save directory.

4. Enter a name for the file and press .

5. Press . Performing Backup displays momentarily, then Figure 8-3.

Figure 8-3. Backup Success
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8.2 Restoring a Database
Before restoring a database, ensure that OnTrak is closed.

1. Open the Database Backup Restore Utility (Start » Programs » Rice Lake Weighing Systems » OnTrak » Database 
Backup Restore Utility).

2. Press .

3. Press  and navigate to the backup files.
4. Select a file and click Open.

Figure 8-4. Restore File

5. Press . Performing Restore displays momentarily, then a confirmation dialog box displays.

8.3 Resetting Indicator Communications
If communications with the indicator are lost and all cables are connected properly, it can easily be reset.

1. From the Help menu, select Reset Indicator Communications. The communications are reset.
2. If communications are still not functional, contact Rice Lake Weighing Systems support.
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9.0 Specifications
System Requirements:
Windows® 10 or newer (x64 systems)

Databases:
10 GB max database size when using the included Microsoft SQL Server Express
Unlimited database size when using a purchased edition (contact Microsoft for details on purchasing a SQL Server)

Communications:
Support for multiple printers
Supports all Rice Lake indicator interfaces
Supports VIRTUi/VIRTUi2 interface
920i-based Automated Ticketing Kiosks
Optional Drivers available for non-Rice Lake weight indicators

Transaction Ticket:
User defined ticket formatting

Reports:
Comprehensive report filters
Optional custom reports

Export Data:
File transfer via XML transaction; exported reports can be saved as PDF/XLS; configurable transaction data export in .CSV file format

Transaction Calculations:
Unlimited product prices and discounts
Tax calculations (does not integrate directly to financial software

Software Support:
Database configuration, field installation and training available
Phone support packages available
Contact Rice Lake for further options

Approvals:
NTEP
CC Number: 05-107
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